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Variables 

 
Programs work by manipulating data stored in memory. These storage areas come under the 

general heading of Variables. In this section, you will see how to set up and use variables. You 

will see how to set up both text and number variables. 

 

String Variables 

 
The first type of variable we will take a look at is called a string. String variables are always text. 

We will write a little program that takes text from a text box, store the text in a variable, and then 

display the text in a message box. However, bear in mind that a variable is just a storage area for 

holding things that you will need later. Think of them like boxes in a room. The boxes are empty 

until you put something in them. You can also place a sticker on the box, so that you will know 

what is in it. Let us look at a programming example. If you have got your project open from the 

previous section, click File from the menu bar at the top of Visual Studio. From the File menu, 

click Close Solution. Start a new project by clicking File again, then New Project. From the New 

Project dialogue box, click on Windows Forms Application. In the Name box at the bottom, type 

String Variables. Click OK, and you will see a new form appear. Add a button to the form, just 

like you did in the previous section. Click on the button to select it (it will have the white squares 

around it), and then look for the Properties Window in the bottom right of Visual Studio. Set the 

following Properties for your new button: 

 

Name: btnStrings 

Location: 90, 175  

Size: 120, 30  

Text: Get Text Box Data 

 

Your form should then look something like this: 
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We can add two more controls to the form, a Label and a Text Box. When the button is clicked, 

we will get the text from the text box and display whatever was entered in a message box. A Label 

is just that: a means of letting your users know what something is, or what it is for. To add a Label 

to the form, move your mouse over to the Toolbox on the left. Click the Label item under 

Common Controls: 

 

 
 

Now click once on your form. A new label will be added: 

 

 
 

The Label has the default text of label1. When your label is selected, it will have just the one white 

square in the top left. When it is selected, the Properties Window will have changed. Notice that 

the properties for a label are very similar to the properties for a button – most of them are the same! 

Change the following properties of your label, just like you did for the button:  

 

Location: 10, 50  

Text: Name  
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You do not really need to set a size, because Visual Studio will automatically resize your label to 

fit your text. However, your Form should look like this: 

 

 
 

Move your mouse back over to the Toolbox. Click on the TextBox entry. Then click on your form. 

A new Text Box will be added, as in the following image: 

 

 
 

Instead of setting a location for your text box, simply click it with your left mouse button. Hold 

your left mouse button down, and then drag it just to the right of the Label. Notice that when you 

drag your text box around, lines appear on the form. These are so that you can align your text box 

with other controls on the form. In the image below, we have aligned the text box with the left 

edge of the button and the top of the Label. 
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OK, time to add some code. Before you do, click File > Save All from the menu bar at the top of 

Visual Studio. You can also run your program to see what it looks like. Type some text in your 

text box, just to see if it works. Nothing will happen when you click your button, because we have 

not written any code yet. Let us do that now. Click the red X on your form to halt the program, 

and you will be returned to Visual Studio. 

 

Code for the Button 
 

Double click your button to open up the coding window. Your cursor will be flashing inside of the 

curly brackets for the button code: 
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Notice all the minus symbols on the left hand side. You can click these, and it will hide code for 

you. Click the minus symbol next to public Form1( ). It will turn into a plus symbol, and the code 

for just this Method will be hidden: 

 

 
 

Hiding code like this makes the rest of the coding window easier to read. Back to the button code, 

though. We are going to set up a string variable. To do this, you need two things: the Type of 

variable you want, and a name for your variable. Click inside the two curly brackets of the button 

code, and add the following: 

 

string firstName; 

 

After the semi-colon, press the enter key on your keyboard to start a new line. Your coding window 

will then look like this: 
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What you have done is to set up a variable called firstName. The Type of variable is a string. 

(Other types are int, float, and Double. These are all number variables that you will meet shortly.) 

When you set up a variable, you always need to tell C# which variable Type you want. Since we 

are going to be getting text from a text box, we need the string Type. After you have told C# which 

Type of variable you want, you then need to come up with a name for your variable. This is like 

the sticker on an empty box. The empty box is the variable Type. Think of these empty boxes as 

being of different sizes and different materials. A big, cardboard box is totally different from a 

small wooden one! However, what you are really doing here is telling C# to set aside some 

memory, and that this storage area will hold strings of text. You give it a unique name so as to tell 

it apart from other items in memory. After all, would you be able to find the correct box, if they 

were all the same size, the same shape, the same color, and had no stickers on them? The name 

you pick for your variables, firstName in our case, can be almost anything you want – it is entirely 

up to you what you call them. However, you should pick something that is descriptive, and gives 

you a clue as to what might be in your variable. We say you can call your variable almost anything. 

But there are some rules, and some words that C# bags for itself. The words that C# reserves for 

itself are called Keywords. There are 77 of these words, things like “using”, “for”, “new”, and 

“public”. If the name you have chosen for your variable turns blue in the coding window, then it 

is a reserved word, and you should pick something else. The only characters that you can use in 

your variable names are letters, numbers, and the underscore character ( _ ). And you must start 

the variable name with a letter, or underscore. You will get an error message if you start your 

variable names with a number. Therefore, these are OK: 

 

firstName  

first_Name  

firstName2 

 

But these are not: 

 

1firstName (Starts with a number) 

first_Name& (Ends with an illegal character) 

first Name (Two words, with a space in between) 

 

Notice that all the variable names above start with a lowercase letter. Because we are using two 

words joined together, the second word starts with an uppercase letter. It is recommended that you 

use this format for your variables (called camelCase notation.) So firstName, and not Firstname.  

After setting up your variable (telling C# to set aside some memory for you), and giving it a name, 

the next thing to do is to store something in the variable. Add the following line to your code (do 

not forget the semi-colon on the end): 

 

firstName = textbox1.Text; 

 

In later versions of C#, you may see a red or blue underline for textbox1. If so, just ignore it for 

now. You will see why. Your coding window will then look like this: 
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To store something in a variable, the name of your variable goes on the left hand side of an equals 

sign. After an equals sign, you type what it is you want to store in the variable. For us, this is the 

Text from textbox1. Except, there is a slight problem. Try to run your code. You should see an 

error message like this one: 

 

 
 

Click No, and have a look at your code: 

 

 
 

There is a blue wiggly line under textbox1. Hold your mouse over this and Visual Studio will tell 

you that: 

 

The name ‘textbox1’ does not exist in the current context. 

 

If you see an error like this, which is quite common, it means that Visual Studio cannot find 

anything with the name you have just typed. Therefore, it thinks we do not have a textbox called 

textbox1. Moreover, we do not! It is called textBox1. We have typed a lowercase “b” when it 

should be an uppercase “B”. Therefore, it is important to remember that C# is case sensitive. This 

variable name: 

 

firstName 



Lab3 - Open Source Software                                                          Microsoft Visual Studio C# 

Page 8 of 41 

 

is different to this variable name: 

 

FirstName 

 

The first one starts with a lowercase “f” and the second one starts with an uppercase “F”. Delete 

the lowercase “b” from your code and type an uppercase “B” instead. Run your program again, 

and you will not see the error message. Now stop your program and return to the coding window. 

The blue wiggly line will have disappeared. What have so far, then, is the following: 

 

string firstName;  

firstName = textBox1.Text; 

 

The first line sets up the variable, and tells C# to set aside some memory that will hold a string of 

text. The name of this storage area will be firstName. The second line is the one that actually 

stores something in the variable – the Text from a text box called textBox1. Now that we have 

stored the text from the text box, we can do something with it. In our case, this will be to display 

it in a message box. Add this line to your code: 

 

MessageBox.Show( firstName ); 

 

The MessageBox.Show( ) Method is one you’ve just used. In between the round brackets, you can 

either type text surrounded by double quotes, or you can type the name of a string variable. If you 

are typing the name of a variable, you leave the double quotes off. You can do this because C# 

knows what is in your variable (you have just told it on the second line of your code.). Run your 

program again. Type something in your text box, and then click the button. You should see the 

text you typed: 

 

 
  

Halt your program and return to the coding window. 
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Assigning text to a String Variable 

 
As well as assigning text from a text box to your variable, you can assign text like this: 

  

firstName = “Home and Learn”; 

 

On the right hand side of the equals sign, we now have some direct text surrounded by double 

quotes. This then gets stored into the variable on the left hand side of the equals sign. To try this 

out, add the following two lines just below your MesageBox line: 

 

firstName = “Home and Learn”;  

MessageBox.Show(firstName); 

 

Your coding window will then look like this: 

 

 
 

Run your program again. Type something in the text box, your own first name. Then click the 

button. You should see two message boxes, one after the other. The first one will display your first 

name. However, the second will display “Home and Learn”. We are using the same variable name, 

here: firstName. The first time we used it, we got the text directly from the text box. We then 

displayed it in the Message Box. With the two new lines, we are typing some text directly in the 

code, Home and Learn, and then assigning that text to the firstName variable. We’ve then added 

a second MessageBox.Show( ) method to display whatever is in the variable.  
 

Concatenation 

 
Another thing we can do is something called Concatenation. Concatenation is joining things 

together. You can join direct text with variables, or join two or more variables to make a longer 

string. A coding example may clear things up. Delete the two new lines you have just added. Now 

add a second variable, just below the first one: 

 

string messageText; 

 

So you coding window should look like this: 
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We want to store some text inside of this new variable, so add the following line of code just below 

string messageText: 

  

messageText = “Your name is: ”; 

 

Your code window will then look like ours below: 

 

 
 

When the message box displays, we want it to say something like “You name is John”. The 

variable we have called messageText holds the first part of the string, “Your name is”. Moreover, 

we are getting the person’s name from the text box: 

 

firstName = textBox1.Text; 

 

The person’s name is being stored in the variable called firstName. To join the two together 

(concatenate) C# uses the plus symbol ( + ). 

 

messageText + firstName 

 

Instead of just firstName between the round brackets of MessageBox.Show( ), we can add the 

messageText variable and the plus symbol: 

 

MessageBox.Show( messageText + firstName ); 

 

Amend your MessageBox line so it is the same as the one above. Here is the coding window: 
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Run your program. Type your first name into the text box, and then click your button. You should 

see something like this: 

 

 
 

Therefore, we set up a variable to hold some direct text, and got the person’s name from the text 

box. We stored this information in two different variables. To join the two together, we used the 

plus symbol. We then displayed the result in a message box. However, you can also do this: 

  

MessageBox.Show( "Your name is: " + firstName ); 

 

Here, we are not storing the text in a variable called messageText. Instead, it’s just direct text 

surrounded by double quotes. Notice, though, that we still use the plus symbol to join the two 

together. 
 

Using other controls to display text 

 
You do not have to use a message box to display the result. You can use other controls, like a 

Label. Let us try it. Add a new Label to your form. Use the Properties Window to set the following 

properties for your new Label: 
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Name: TextMessage  

Location: 87, 126  

Text: Message Area 

 

Return to your coding window, and add two forward slashes to the start of your 

MessageBox.Show( ) line. The line should turn green, as in the following image: 

 

 
 

The reason it turns green is that two forward slashes are the characters you use to add a comment. 

C# then ignores theses lines when running the program. Comments are a very useful way to remind 

yourself what the program does, or what a particular part of your code is for. Here is our coding 

window with some comments added: 

 

 
 

You can also use the menu bar, or the toolbar, to add comments. Highlight any line of text in your 

code. From the menu bar at the top of Visual Studio, select Edit > Advanced > Comment 

Selection. Two forward slashes will be added to the start of the line. You can quickly add or 
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remove comments by using the toolbar. Locate the following icons on the toolbars at the top of 

Visual Studio: 

 

 
 

In version 2012, the comment icons look like this: 

 

 
  

The comment icons are circled, in the images above. The first icon adds a comment, and the second 

one removes a comment. (If you cannot see the above icons anywhere on your toolbars, click View 

> Toolbars > Text Editor.). Now that you have commented out the MessageBox line, it will not 

get executed when your code runs. Instead, add the following like to the end of your code: 

 

TextMessage.Text = messageText + firstName; 

 

Your coding window should then look like this: 

 

 
  

Run your program again. Type your name in the text box, and then click your button. The message 

should now appear on your label, instead of in a Message Box: 
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The reason is does so is because you are now setting the Text property of the Label with code. 

Previously, you changed the Label’s Text Property from the Properties Window. The name of our 

label is TextMessage. To the right of the equals sign, we have the same code that was in between 

the round brackets of the Show ( ) method of the MessageBox.  

 

OK, time for an exercise. 
 

Add a second text box to your form. Display your message in the text box as well as on the label. 

Therefore, if your name is John, your second text box should have: “Your name is: John” in it after 

the button is clicked. When you complete this exercise, your form should look like this, when the 

button is clicked:  

 

 
 

We are now going to move away from string variables and on to number variables. The same 

principles you have just learnt still apply, though: 

 

 Set up a variable, and give it a name  

 Store something in the variable  

 Use code to manipulate what you have stored  

 

 

 

 

 

 

 

 

 

 

 



Lab3 - Open Source Software                                                          Microsoft Visual Studio C# 

Page 15 of 41 

 

Numbers 

 
There are a few different types of number variables. The ones you will learn about now are Integer, 

Double and Float. First up, though, are Integers. Close any solution you have open by clicking 

File > Close Solution from the menu bar at the top of Visual Studio. Start a new project by clicking 

File > New Project. From the New Project dialogue box, select Windows Forms Application 

from the available templates. Type a Name for your project. Call it Numbers. Click OK, and you 

will have a new form to work with. 

 

Integers 

 
An integer is a whole number. It is the 6 of 6.5, for example. In programming, you will work with 

integers a lot. However, they are just variables that you store in memory and want to manipulate. 

Add a button to your form, and set the following properties for it in the Properties Window: 

 

Name: btnIntegers  

Text: Integers  

Location: 110, 20 

 

Now double click your button to get at the code: 

 

 
 

In the previous section, you saw that to set up a string variable you just did this: 

 

string myText; 

  

You set up an integer variable in the same way. Except, instead of typing the word string, you type 

the word int (short for integer). So, in between the curly brackets of your button code, type int. 

You should see the word turn blue, and the IntelliSense list appear: 
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Either press the enter key on your keyboard, or just hit the spacebar. Then type a name for your 

new variable. Call it myInteger. Add the semi-colon at the end of your line of code, and hit the 

enter key. Your coding window will then look like this: 

 

 
 

Notice the text in the yellow box, in the image one up from the one above. It says: 

 

Represents a 32-bit signed integer 

 

A signed integer is one that can have negative values, like -5, -6, etc. (The opposite, no negative 

numbers, is called an unsigned integer.) The 32-bit part is referring to the range of numbers that 

an integer can hold. The maximum value that you can store in an integer is: (2,147,483,648). The 

minimum value is the same, but with a minus sign on the front: (-2,147,483,648). To store an 

integer number in your variable, you do the same as you did for string: type the name of your 

variable, then an equals sign ( = ), then the number you want to store. So add this line to your code 

(don’t forget the semi-colon on the end): 

  

myInteger = 25; 

 

Your coding window should look like this: 
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Therefore, we have set up an integer variable called myInteger. On the second line, we are storing 

a value of 25 inside of the variable. We will use a message box to display the result when the 

button is clicked. So add this line of code for line three: 

 

MessageBox.Show(myInteger); 

 

Now try to run your code. You will get the following error message: 

  

 
 

You should see a blue wiggly line under your MessageBox code: 

 

 
 

Hold your mouse over myInteger, between the round brackets of Show( ). You should see the 

following yellow box: 

 

 
  

The error is “Cannot convert from int to string”. The reason you get this error is because myInteger 

holds a number. However, the MessageBox only displays text. C# does not convert the number to 

text for you. It does not do this because C# is a programming language known as “strongly typed”. 

What this means is that you have to declare the type of variable you are using (string, integer, 

double). C# will then check to make sure that there are no numbers trying to pass themselves off 

as strings, or any text trying to pass itself off as a number. In our code above, we are trying to pass 

myInteger off as a string. In addition, C# has spotted it! What you have to do is to convert one 
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type of variable to another. You can convert a number into a string quite easily. Type a full stop 

(period) after the “r” of myInteger. You will see the IntelliSense list appear: 

 

 
 

Select ToString from the list. Because ToString is a method, you need to type a pair of round 

brackets after the “g” of ToString. Your code will then look like this (we have highlighted the 

new addition): 

 

 
 

The ToString method, as its name suggests, converts something to a string of text. The thing we 

are converting is an integer. Start your program again. Because you have converted an integer to 

a string, you should find that it runs OK now. Click your button and you should see the message 

box appear: 
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Doubles and Float 

 
Integers, as was mentioned, are whole numbers. They cannot store the point something, like .7, 

.42, and .007. If you need to store numbers that are not whole numbers, you need a different type 

of variable. You can use the Double type, or the float type. You set these types of variables up in 

exactly the same way: instead of using the word int, you type double, or float. Like this: 

 

float myFloat; 

double myDouble; 

 

(Float is short for “floating point”, and just means a number with a point something on the end.). 

The difference between the two is in the size of the numbers that they can hold. For float, you can 

have up to 7 digits in your number. For doubles, you can have up to 16 digits. To be more precise, 

here is the official size: 

 

float: 1.5 × 10−45 to 3.4 × 1038 

double: 5.0 × 10−324 to 1.7 × 10308 

 

Float is a 32-bit number and double is a 64-bit number. To get some practice using floats and 

doubles, return to your form. If you cannot see the Form1.cs [Design] tab at the top, right click 

Form1.cs in the Solution Explorer on the right hand side. (If you cannot see the Solution Explorer, 

click View > Solution Explorer from the menu bar at the top.). 

 

 
 

Add a new button to your form. Set the following properties for it in the Properties Window: 

 

Name btnFloat  

Location: 110, 75  

Text: Float 
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Double click your new button, and add the following line to the button code: 

 

float myFloat; 

 

Your coding window will then look like this: 

 

 
 

To store something inside of your new variable, add the following line: 

 

myFloat = 0.42F; 

 

The capital letter F on the end means Float. You can leave it off, but C# then treats it like a double. 

Because you have set the variable up as a float, you will get errors if you try to assign a double to 

a float variable. Add a third line of code to display your floating point number in a message box: 

  

MessageBox.Show( myFloat.ToString( ) ); 

 

Again, we have to use ToString( ) in order to convert the number to a string of text, so that the 

message box can display it. However, your coding window should look like ours below: 

 

 
 

Run your program and click your Float button. You should see a form like this: 
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Halt the program and return to your coding window. Now delete the capital letter F from 0.42. The 

line will then be: 

 

myFloat = 0.42; 

 

Try to run your program again. You will get an error message and a blue wiggly line under your 

code. Because you have missed the F out, C# has defaulted to using a double value for your 

number. A float variable cannot hold a double value, confirming that C# is a strongly typed 

language. (The opposite is a weakly typed language. PHP and JavaScript are examples of weakly 

typed languages – you can store any kind of values in the variables you set up.). Another thing to 

be careful of when using float variables is rounding up or down. As an example, change the number 

from 0.42F to 1234.567F. Now run your program, and click your float button. The message box 

will be this: 

 

 
 

Halt the program and return to your code. Now add an 8 before the F and after the 7, so that your 

line of code reads: 

 

myFloat = 1234.5678F; 

 

Now run your program again. When you click the button, your message box will be this: 
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It has missed the 7 out! The reason for this is that float variables can only hold 7 numbers in total. 

If there is more than this, C# will round up or down. A number that ends in 5 or more will be 

rounded up. A number ends in 5 or less will be rounded down: 

  

1234.5678 (eight numbers ending in 8 – round up)  

1234.5674 (eight numbers ending in 4 – round down)  
 

The number of digits that a variable can hold is known as precision. For float variable, C# is precise 

to 7 digits: anything more and the number is rounded off. 

 

Double values 

 
Add another button to your form, and set the following properties for it in the Properties Window: 

 

Name btnDouble  

Location: 110, 130  

Text: Double 

 

Double click your new button to get at the code. Add the following three lines to your button code: 

 

double myDouble;  

myDouble = 0.007;  

MessageBox.Show(myDouble.ToString()); 

 

Your coding window should now look like this: 

 

 
 

Run your program and click your new button. You should see this: 
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You also need to be careful of precision when using double variable types. The double type can 

hold up to 16 digits. Halt your program and return to the coding window. Change this line: 

 

myDouble = 0.007; 

 

to this: 

 

myDouble = 12345678.1234567; 

 

Run your program and click your double button. The message box correctly displays the number. 

Add another number on the end, though, and C# will again round up or down. The moral is, if you 

want accuracy, careful of rounding! 

  

Simple addition 

 
We will now use variables to do some adding up. After you have learned how to add up with the 

three number variable types, we can move on to subtraction, multiplication, and division. Start a 

new project for this. So click File > Close Solution from the menu bar at the top of Visual Studio. 

Then click File > New Project. Type arithmetic as the Name of your new Windows Forms 

Application project. Click OK to create the new project. Add a button to your new form, and set 

the following properties for it in the Properties Window: 

  

Name: btnAdd  

Size: 100, 30  

Text: Integer – Add 

 

Move the button to the top of your form. Then double click it to get at the coding window. Set up 

the following three integer variables in your button code: 

 

int firstNumber;  

int secondNumber;  

int integerAnswer;  
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Your coding window should look like ours below: 

 

 
 

We now need to put something into these variables. We will store 10 in the first number, and 32 

in the second number. So add these two lines to your code: 

 

firstNumber = 10;  

secondNumber = 32; 

 

Your coding window will then look like this: 

 

 
 

Therefore, the numbers we want to store in the variables go on the right hand side of the equals 

sign; the variable names go on the left hand side of the equals sign. This assigns the numbers to 

the variables – puts them into storage. We now want to add the first number to the second number. 

The result will be stored in the variable we have called integerAnswer. Fortunately, C# uses the 

plus symbol (+) to add up. Therefore, it is fairly simple. Add this line to your code: 

 

integerAnswer = firstNumber + secondNumber; 

 

And here’s the coding window: 
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We have already stored the number 10 in the variable called firstNumber. We have stored 32 in 

the variable secondNumber. Therefore, we can use the variable names to add up. The two 

variables are separated by the plus symbol. This is enough to tell C# to add up the values in the 

two variables. The result of the addition then gets stored to the left of the equals sign, in the variable 

called integerAnswer. Think of it like this: 

 

 

 
Calculate this sum first 

 

 
Store the answer here 

 

To see if all this works or not, add a message box as the final line of code: 

 

MessageBox.Show( integerAnswer.ToString( ) ); 

 

We’re just placing the integerAnswer variable between the round brackets of Show( ). Because 

it’s a number, we’ve had to use ToString( ) to convert the number to text. Here is what your coding 

window should look like now: 
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And here’s the form when the button is clicked: 

 

 
 

You do not have to store numbers in variables if you want to calculate things. You can just add up 

the numbers themselves. Like this: 

 

integerAnswer = 10 + 32; 

 

And even this: 

 

integerAnswer = firstNumber + 32; 

 

So you can add up just using numbers, or you can mix variable names with numbers. As long as 

C# knows that there is a number in your variable, and that it is the right type, the addition will 

work. You can use more than two variables, or more than two numbers. So you can do this: 

 

integerAnswer = firstNumber + secondNumber + thirdNumber; 

 

or this: 

 

integerAnswer = firstNumber + secondNumber + 32; 

 

And this: 

 

integerAnswer = firstNumber + 10 + 32; 

 

The results is the same: C# adds up whatever you have on the right hand side of the equals sign, 

and then stores the answer on the left hand side. 
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Adding up with float Variables 

 
You add with float variables in exactly the same way – with the plus symbol. You can even mix 

integer variables with float variables. However, you have to take care! Add another button to your 

form, and set the following properties for it in the Properties Window: 

 

Name: btnAddFloats  

Size: 100, 30  

Text: Float – Add 

 

Double click your button to get at the code. Set up the following variables: 

 

float firstNumber;  

float secondNumber;  

float floatAnswer; 

 

And here’s the coding window: 

 

 
 

(Notice that we have used the same names for the first two variables. C# does not get confused, 

because they are in between the curly brackets of the button code. You can set up variables outside 

of the curly brackets. We will do this when we come to code the calculator, at the end of this 

section. Then something called scope comes in to play.). To place something in your new 

variables, add the following code: 

 

firstNumber = 10.5F;  

secondNumber = 32.5F;  

floatAnswer = firstNumber + secondNumber; 

 

Finally, add you message box line: 

 

MessageBox.Show( floatAnswer.ToString( ) ); 

 

The coding window should look like this: 
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Run your form and click your new button. You should see this: 

 

 
 

So 10.5 + 32.5 equals 43. Halt your form by clicking the red X, and return to your coding window. 

As was mentioned, you can add float and integer values together. But you need to take care. Try 

this: 

 

Add the following variable to your code: 

int integerAnswer; 

And then change this line:  

floatAnswer = firstNumber + secondNumber; 
to this:  

integerAnswer = firstNumber + secondNumber; 
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So it is just the name of the variable before the equals sign that needs to be changed. Amend you 

message box line from this: 

  

MessageBox.Show( floatAnswer.ToString( ) ); 

 

to this: 

 

MessageBox.Show( integerAnswer.ToString( ) ); 

 

Your coding window will then look like this: 

 

 
 

Try to run your code. The program will not execute, and you will have a blue wiggly line: 

 

 
 

Hold your mouse over the blue wiggly line and you will see an explanation of the error: 
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Not much, help, if you are a beginner! However, what it is telling you is that the first number and 

the second number are float variables. The answer to the addition was also a float. However, you 

were trying to store the answer in an integer variable. C# will not let you store float values in an 

integer. The error message is saying that you need to convert them first. You can indeed convert 

float values to integers. You do it like this: 

  

integerAnswer = (int)firstNumber + (int)secondNumber; 

 

Therefore, you type the word int between a pair of round brackets. This goes before the number 

you want to convert. It does mean that the point something on the end will get chopped off, though. 

So 10.5 becomes 10, and 32.5 becomes 32. Not good for accuracy, but at least the program will 

run! Try it out, and you should see an answer of 42 when you click your button. Therefore, the 

moral is this: 

 

 
 

If you are expecting an answer that ends in point something, use a float variable (or a double). 

(You may have a green wiggly line under float floatAnswer. This is because you are not storing 

anything in this variable. Do not worry about it!). Note that the other way round is not a problem 

– you can store an integer in a float value. Have a look at this slight change to the code: 

First, notice the new way we are storing the number 20 into the integer variable called 

integerAnswer: 

 

int integerAnswer = 20; 

 

Instead of two lines, we have just used one. This is fine, in C#. However, you are doing two things 

on the same line: setting up the variable, and placing a value in it. The second thing to notice is 

that we are adding up two float values (firstNumber and secondNumber) and an integer 

(integerAnswer). We are then storing the answer into a float variable (floatAnswer). Try it out 

and you will find that the code runs fine. If we change this line:  

 

firstNumber = 10.5F;  
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to this:  

 

firstNumber = 10; 

 

Then, again, the program will run fine. In other words, you can store an integer in a float variable, 

but you cannot store a float value in an integer variable. Hopefully, that was not too confusing! 

We will move on to subtraction, now. But if you want to use a double variable instead of a float 

variable the same things apply – be careful of what you are trying to store, and where! 

 

Subtraction 

 
Subtraction is fairly straightforward in C#. To subtract one number from another, you used the 

minus symbol ( - ). Add another button to your form. Set the following properties for it in the 

Properties Window: 

 

Name: btnSubtract  

Size: 100, 30  

Text: Subtract 

 

Double click the button to get at the code. Add the following three lines of code: 

 

int answerSubtract;  

answerSubtract = 50 - 25;  

MessageBox.Show( answerSubtract.ToString() ); 

 

Your coding window will then look like this: 

 

 
 

Therefore, we’ve set up an integer variable called answerSubtract. On the second line, we are 

using the minus symbol to subtract 25 from 50. When C# works out the answer to 50 – 25, it will 

place the answer to the left of the equals sign, in the answerSubtract variable. On the final line, 

we are displaying the answer in a message box. Run your code, and make sure it works. The answer 

you should see in the message box is, of course, 25. Stop your program and return to the coding 

window. Now change the 25 to 25.5. 

 

answerSubtract = 50 – 25.5; 
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Try to run your program and you will get the blue wiggly line, meaning there is an error in your 

code. The reason is the same as for addition: we are trying to place a float number into an integer 

variable (the answer will be 24.5, this time). Just because the math symbol has changed does not 

mean we can disobey the C# rules! Change it back to 25, and the code will run fine. As with 

addition, you can subtract more than one number. Change your line to this: 

 

answerSubtract = 50 - 25 - 10 - 2; 

 

When you run your program, you should see 13 in your message box, the answer to the subtraction.  

You can also use variable names in your subtraction. Add the following integer variable to your 

code: 

 

int numberOne = 12; 

 

Then change the second line to this: 

 

answerSubtract = 50 - numberOne; 

 

Here is what your coding window should look like: 

 

 
 

What we are doing here is setting up an integer variable called numberOne. We are then placing 

a value of 12 inside of the variable – all on the same line. For the second line, we are subtracting 

whatever is in the variable called numberOne from 50. Run you program and click your button. 

You should see an answer of 38 in your message box. 

 

Mixing Subtraction and Addition 

 
You can mix subtraction and addition. The process is quite straightforward. What we will do next 

is to add two numbers together, and then subtract a third number from the total. Add another button 

to your form. Set the following properties for it: 

 

Name: btnMixed  

Size: 100, 30  

Text Add and Subtract 
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(If you need to make your Form bigger, click on the form to select it. Then change the Size property 

in the Properties Window.). Double click your button to get at the code. We will need four integer 

variables for this. So set up the following: 

 

int firstNumber;  

int secondNumber;  

int thirdNumber;  

int answer; 

 

To place values in the variables, add the following three lines: 

  

firstNumber = 100;  

secondNumber = 75;  

thirdNumber = 50; 

 

Your coding window will then look like this: 

 

 
 

To add the first number to the second number, and then place the result in the variable we have 

called answer, add the following line to your code: 

 

answer = firstNumber + secondNumber; 

 

Display the answer in a message box by adding this line: 

 

MessageBox.Show( answer.ToString( ) ); 

 

When you run the program and click your button, you should see the message box display an 

answer of 175. Stop the program and return to your code. We now want to subtract the third number 

from the first two. So change this line: 

 

answer = firstNumber + secondNumber; 

 

to this: 

 

answer = firstNumber + secondNumber - thirdNumber; 
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When C# sees all these variables after the equals sign, it will try to calculate using the numbers 

you have stored in the variables. Usually, it will calculate from left to right. Therefore, this bit gets 

done first: 

 

firstNumber + secondNumber 

 

When C# finishes adding the first two numbers, it will then deduct the value in thirdNumber. The 

answer is then stored in the variable to the left of the equals sign. Run your program. When the 

button is clicked, the message box will display an answer of 125. 

 

Operator Precedence 
 

The symbols you have been using ( + and - ) are known as Operators. Operator Precedence refers 

to the order in which things are calculated. C# sees the plus (+) and the minus ( – ) as being of 

equal weight, so it does the calculating from left to right. But this “left to right” calculating can 

cause you problems. Change the plus into a minus in your code, and the minus into a plus. So 

change it to this: 

 

answer = firstNumber - secondNumber + thirdNumber; 

 

Run your code. When the button is clicked, an answer of 75 will appear in the message box. This 

is “left to right” calculation. What you wanted here was: 

 

firstNumber – secondNumber 

 

Then when the answer to that is found, add the thirdNumber. Therefore, the sum is this: 100 – 

75, which equals 25. Then 25 + 50, which equals 75. However, what if you did not mean that? 

What if you wanted firstNumber minus the answer to secondNumber + thirdNumber? In case that 

is not clear, some brackets may help clear things up. Here is the two ways of looking at our 

calculation: 

 

( firstNumber – secondNumber ) + thirdNumber 

firstNumber – ( secondNumber + thirdNumber ) 

 

In maths, brackets are a way to clear up your calculations. In the first one, whatever is between the 

round brackets is calculated first. The total of the sum in brackets is then added to thirdNumber. 

In the second one, it’s the other way around: secondNumber is first added to thirdNumber. You 

then deduct from this total the value of firstNumber. You can use brackets in programming, as 

well. Add the following brackets to your code: 

 

answer = firstNumber - (secondNumber + thirdNumber); 

 

Your coding window should then look like this: 
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When you run your program and click the button, this time the answer is minus 25. Previously, the 

answer was 75! The reason the answer is different is because you’ve used brackets. C# sees the 

brackets and tackles this problem first. The next thing it does is to deduct firstNumber from the 

total. Without the brackets, it simply calculates from left to right.  

 

Multiplication and Division 

 
To multiply and divide, the following symbols are used in programming:  

 

*     Multiply  

/      Divide  

 

Change your code to this: 

  

answer = ( firstNumber + secondNumber ) * thirdNumber; 

 

Because of the brackets, the first thing that C# does is to add the value in firstNumber to the value 

in secondNumber. The total is then multiplied ( * ) by the value in thirdNumber. With the values 

we currently have in the variables, the sum is this: 

 

answer = ( 100 + 75 ) * 50 

 

Run your program and click your button. The answer you should get is 8750. Return to the coding 

window. Now remove the two round brackets. Your coding window will then be this: 
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Run your program again. Click the button. This time, the answer is 3850! The reason it is different 

is because of Operator Precedence. With the brackets, you forced C# to calculate the addition first. 

Without the brackets, C# no longer calculates from left to right. Therefore, it is not doing this: 

 

( 100 + 75 ) * 50 

 

C# sees multiplication as having priority over addition and subtraction. Therefore, it does the 

multiplying first. It does this: 

 

100 + ( 75 * 50 ) 

 

The two give you a totally different answer. The same is true of division. Try this. Amend your 

line of code to the following: 

 

answer = ( firstNumber + secondNumber ) / thirdNumber; 

 

Run the program and the answer will be 3. (The real answer to (100 + 75) / 50 is, of course, 3.5. 

However, because we are using integer variables and not floats, the point something at the end 

gets chopped off.). So we’re using the divide symbol now ( / ), instead of the multiplication symbol 

(*). The addition is done first, because we have a pair of round brackets. The total of the addition 

is then divided by the value in thirdNumber. Return to the code, and change the line to this: 

  

answer = firstNumber + secondNumber / thirdNumber; 

 

So, just remove the round brackets. Run your program again, and you will find that the answer in 

the message box is now 101. (It would have been 101.5, if we had used float variables instead of 

integers.). If you now replace the plus symbol ( + ) above with a multiplication symbol ( * ), C# 

switches back to “left to right” calculation. This is because it sees division and multiplication as 

having equal weight. The answer you will get without brackets is 150. 
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Getting numbers from text boxes 

  
We are going to change tack slightly, here. What we will do is show you how to get numbers from 

text boxes, and then use these numbers in your code. You will need to be able to do this for your 

calculator. Start a new project for this one by clicking File > New Project from the menu bar at 

the top of Visual Studio. Add a text box and a button to your new form. Set the following Properties 

for the text box (the tb below stands for text box):  

 

Name: tbFirstNumber  

Size: 50, 20  

Location: 40, 35  

Text: 10  

 

And set the following properties for your button:  

 

Name: btnAnswer  

Size: 75, 25  

Location: 90, 90  

Text: Answer  

 

Your form will then look like this: 

 

 
 

What we want to do is to get that number 10 from the text box and display it in a message box. So 

double click your button to get at the coding window. Your cursor will be flashing inside of the 

button code. Set up two integer variables at the top of the button code: 

 

int firstTextBoxNumber;  

int answer;  
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Your coding window should look like this: 

 

 
 

To get at the number in the text box, we can use the Text property of text boxes. Here is the line 

of code to add: 

 

firstTextBoxNumber = tbFirstNumber.Text; 

 

This says; find a text box called tbFirstNumber. Access its Text property. When the Text property 

is retrieved, store it in the variable called firstTextBoxNumber. To display the number in a 

message box, add this line: 

 

MessageBox.Show( firstTextBoxNumber.ToString( ) ); 

 

Try to Run your code. You should find C# would not run it at all. It will give you the following 

error: 

 

 
  

With text boxes, the thing that you get is, not surprisingly, text. However, we are trying to store 

the text from the text box into an integer variable. C# will not let you do this – whole numbers 

belong in integer variables, not text. The error message is telling you that C# cannot do the 

conversion from text to numbers for you – you have to do it yourself! Therefore, we need to convert 

the text from the text box into an integer. The way you do this is to use something called Parsing. 

Fortunately, this involves nothing more complex that typing the word “Parse”. You can do 

different types of Parses. Because we need to convert the text into an integer, we need an Integer 

Parse. So change the line to this: 

  

firstTextBoxNumber = int.Parse( tbFirstNumber.Text ); 
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Therefore, you type int, then a full stop. From the IntelliSense menu, you can double click Parse. 

In between a pair of round brackets, you type the text you want to convert. In our case, the text is 

coming from a text box. However, it does not have to. You can do this: 

 

firstTextBoxNumber = int.Parse( “10” ); 

 

In the code above, the number is in double quotes. Double quotes mean that it is text. Using 

int.Parse( ) means that it will be converted to a number that you can store in an integer variable.  

Run your program and you will find that it works OK now. (You will have a green wiggly line 

under answer, but that is just because we have not used this variable yet.) Click your button and 

the number 10 will appear in the message box. Type a different number in your text box, and click 

the button again. The new number should appear in place of the old one. You can also Parse other 

types of variable. Like this: 

 

float firstTextBoxNumber; 

firstTextBoxNumber = float.Parse( tbFirstNumber.Text ); 

 

Or this: 

 

double firstTextBoxNumber  

firstTextBoxNumber = double.Parse( tbFirstNumber.Text ); 

 

In the first one, we have set up a float variable. We’ve then used float.Parse( ) to convert the text 

from the text box, so that it can be stored in the float variable. We have done exactly the same 

thing in the second example, to convert the text into a double. Things get more complicated if you 

accidentally try to store a double value in a float variable – your program will crash! You need to 

try to catch things like this with code. (You will see how to test for errors like this later in the 

book.) For now, let us move on. OK, so we have grabbed a number from a text box and displayed 

it in a message box. What we will do now is to add a second text box, get numbers from both, use 

our Math operators, and do some calculations with the two number we took from the text boxes. 

Sounds complex, but it is not! Add a second text box to your form. Set the following Properties 

for it in the Properties Window: 

 

Name: tbSecondNumber  

Size: 50, 20  

Location: 165, 35  

Text: 5  

 

Your form will then look like this: 
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Double click the button to get at your code. Now set up another integer variable to hold the second 

number from the new text box: 

 

int secondTextBoxNumber; 

 

To store the number from the text box in this new variable, add the following line: 

 

secondTextBoxNumber = int.Parse( tbSecondNumber.Text ); 

 

This is the same as before – use int.Parse to convert the number from the text box into an integer 

variable. Then store the number in the new variable. Let us add the two numbers up, first. We can 

use the answer variable for this. Here is the code to add: 

 

answer = firstTextBoxNumber + secondTextBoxNumber; 

 

So we’re just using the plus symbol ( + ) to add up whatever is in the two variables. The numbers 

in the variables come from the two text boxes. Amend your message box line to this: 

  

MessageBox.Show( answer.ToString( ) ); 

 

All you need to do is to change the name of the variable that you are converting ToString( ).  

Your coding window should look like ours: 
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Run your program, and then click the button. You should see the answer to the addition in your 

message box: 

 

 
 

Change the numbers in the text boxes, and click your button again. When you have finished playing 

with your new form, click the red X to return to the code. Here is a few exercises for you to try. 


